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Abstract
High-resolution 3D reconstructions of the cerebral vasculature are essential for preoperative planning of
complex interventions in vascular neurosurgery. Quick-segmentation algorithms provided by expensive
radiology applications often result in unsatisfactory 3D reconstructions. Here we show how to quickly
segment and print a detailed 3D model of the cerebral vasculature without extensive knowledge in 3D
modeling. Exceptionally using freeware, the total costs for the generation of a real size model of the circle
of Willis are less than $10. The 3D models will be particularly valuable during preoperative planning and
for patient information.

Introduction
In order to treat complex diseases of the cerebral vasculature, precise high-resolution imaging is
indispensable. Medical slice imaging is usually provided in three orthogonal 2D planes for diagnostic
evaluation and surgical planning. The anatomically complex structures of the cerebral vasculature with
their close relationship to crucial structures such as cranial nerves, brain parenchyma and the skull base
require precise 3D imaging. In most cases, 3D reconstructions are provided by the hospital’s radiology
department. However, these 3D reconstructions only represent a few snapshots of a 3D model, which can
be scrolled through in only one given direction. These conventional 3D images have major
disadvantages. Often the quality of the 3D reconstruction is insu�cient when using quick-segmentation
algorithms of common radiology applications. 3D segmentation can be very time-consuming and a lot of
knowledge about the upcoming surgical procedure is needed. Because the surgeons know best which
structures are of particular interest, they should be involved in 3D segmentation and modeling. Until now,
3D segmentation of Digital Imaging and Communications in Medicine DICOM data has been laborious,
required advanced knowledge in the use of non-intuitive software and required considerable �nancial
expenditure to acquire the corresponding licenses.

3D printing is currently a big hype and 3D design and printing is widely used in virtually all industries and
as a hobby of millions of private users around the globe. As a result, numerous 3D segmentation and
design programs are currently available for use. In the spirit of the 3D community, many of the
applications are open-source and can be downloaded for free. In addition, these applications are very
easy to use and there are instructional videos online for almost any problem to be encountered.

In surgery, the advances in 3D printing technology have sparked a revolution. 3D models improve the
surgeon's anatomical understanding in surgical planning 1 2 surgery time can be shortened, blood loss
reduced and the outcome improved 3,4.

Here we show how any practitioner can create a high-quality 3D reconstruction of the cerebral
vasculature based on standard MR imaging in very short time and without advanced knowledge in 3D
segmentation. The 3D segmentation is performed exceptionally using freeware and therefore is
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affordable for everyone. We also provide instructions on how to create a 3D print of the circle of Willis in
original size from a 3D mesh.

Materials And Methods

1. Data acquisition
Gadolinium contrast-enhanced time of �ight TOF 3D MRI sequences were used as a basis for
segmentation of the cerebral vasculature. Data acquisition was performed on a Siemens Magnetom MRI
device. Imaging data has been converted to DICOM �les for further processing.

2. Segmentation of the cerebral vasculature
3D Slicer, an open-source platform for analyzing medical image data (www.slicer.org) was used to
segment the cerebral vasculature from contrast-enhanced TOF 3D MRI sequences. After having launched
3D Slicer, DICOM �les were imported into the DICOM browser of 3D Slicer by simply drag and drop the
DICOM �les on the “Load DICOM Data” button. The DICOM browser will open automatically and the
correct Patient, the study (MRI) and the series (TOF 3D Gadolinium) was chosen, proceeded by pressing
load button. The main window of 3D slicer will open depicting the MRI dataset in all 3 planes axial,
coronal and sagittal. “Segment Editor” was opened in the module list. By pressing the “+Add” button a
new segment was created and the new “Segment_1” appeared in green color. The cerebral vessels are
bright white in contrast-enhanced TOF 3D MRI slices, while the brain parenchyma and the skull are
grayish. In order to take advantage of the intensity difference the threshold function was launched by
pressing “Threshold” button which allows to set a threshold range by shifting both the minimal and the
maximal value slider. The selection can be controlled in real time in all 3 planes. As the contrast-
enhanced vessels are the most intense structures in the scan, the maximal slider was set in maximal top
right position. The minimal slider has to be adapted: Around intensity values of 150 the skull, the orbit
and some of the brain parenchyma will be selected. After 200 there are muscles, orbital vessels and the
mucosa of the paranasal sinuses left. Up to 300 it is not possible to differentiate the cavernous segment
of the internal carotid artery from cavernous sinus. With even higher settings, the selection is more
speci�c for cerebral vasculature but you will start losing selection of small arterial branches from A/M/P
3 upwards. Therefore, a minimal threshold value of 300 was set as a right compromise. This lower
threshold value may vary depending on what system or sequence is used. For contrast-enhanced T1
sequences, the lower threshold level is considerably higher compared to TOF Gadolinium, because brain
parenchyma appears in a lighter shade of gray. Values of around 700 will work for T1 Gadolinium
sequences. By pressing the “Show 3D” button a 3D reconstruction was generated. In order to get rid of
any vessels not connected to the circle of Willis the “Islands” tool was used. The application of the “Keep
largest island” function was resulting in a pretty decent 3D segmentation of the cerebral arteries forming
the circle of Willis up to the M4 branches (Fig. 1). Unwanted structures such as the greater vein of Galen,
parts of the sigmoid sinus and branches of the external carotid artery were then cropped by using the
scissors tool in the modus “erase inside” where you can draw circles directly in the 3D reconstruction

http://www.slicer.org/
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window. Finally the 3D reconstruction had to be exported as a 3D model in a printable �le such as stl, vtk
or ply. To do so, “Data” was chosen in the module list and on the left, the hierarchy tree showed up. A
right-click on “Segment_1” allowed to choose “Export visible segments to models”. With the “Save” button
the 3D model was saved as an stl �le.

3. Geometric surface preparation
3.1. Meshmixer

The 3D model was imported into Meshmixer (www.meshmixer.com), a freeware for working with triangle
meshes by pressing “+Import” and selection of the corresponding �le. Unwanted branches could be easily
selected with the selection tool and showed up in orange color. By pressing “x”-key the selected parts
were deleted (Fig. 2). Then the mesh was automatically inspected in order to �ll holes and close the
surface by pressing “Analysis -> Inspector-> Auto repair all”. All of these functions are embedded in
Blender software as well but the use of Meshmixer is way more intuitive for the 3D-beginner.

1. Blender

Blender, an open-source 3D computer graphics software (www.blender.org) was used for further surface
preparation. The stl �le previously modi�ed in Meshmixer was imported by choosing “File -> Import ->
Stl”. Then the mesh was smoothened either by going to the Edit Mode with tab key and pressing “smooth”
in the tools selection bar or by adding “Smooth” or “Laplacian Smooth modi�er”. In order to display the
model, a cube was created by choosing “Add -> mesh -> cube” and the cube was scaled by pressing “S”
key to �t below our model. The patient’s case number was engraved on the stand by adding a text (Add ->
Text) in Edit mode (Fig. 3). To save computing power, the number of vertices was reduced with decimate
modi�er (Add Modi�er -> Decimate), a ratio of 0.5 which reduces the vertices by half was applied. Finally,
the optimized model was exported as a new stl �le (File -> Export -> Stl).

4. 3D printing
The model was printed using an Ultimaker 3 dual extruder 3D printer (www.ultimaker.com). The de�nitive
stl �le was imported in Cura software (ultimaker.com/software/ultimaker-cura). Red polylactic acid PLA
was chosen for printing the vessels and the stand. The water-soluble polyvinyl alcohol PVA �lament
served as a support �lament in order to print overhanging structures. The print was performed at a layer
thickness of 0.15 mm. After printing, PVA supports were dissolved in water during 24 hours and the �nal
model was dried at ambient temperature (Fig. 4).

Discussion
3D modeling starts with data acquisition. Every modality of 3D medical imaging such as MRI, CT, CTA,
MRA, DSA or PET is suitable for 3D printing. The medical dataset is usually stored as a DICOM (Digital
Imaging and Communications in Medicine) �le. For cerebral vasculature, the best resolution would be

http://www.slicer.org/
http://www.slicer.org/
http://www.slicer.org/


Page 5/11

obtained by using 3D reconstructions of cerebral angiographs5. If angiography imaging is used, the
disadvantage is that only the supply area of one cerebral vessel is depicted at the same time. Therefore,
angiography data sets are not suitable for the reconstruction of the circle of Willis. We decided to select
DICOM �les of contrast enhanced Time of Flight TOF sequences which are part of our standard MRA
protocol.

Next, a 3D reconstruction has to be generated using slice imaging data. Applications like 3D Slicer are
able to do this automatically. From the 3D reconstruction of the entire dataset, the structure of interest is
selected or so called segmented. This step requires medical knowledge to identify the correct structures.
Ideally, the surgeon himself will perform the segmentation which allows him to focus on areas of interest
and to prepare for the upcoming surgical procedure. Segmentation is already a �eld for the application of
arti�cial intelligence AI but the freeware available is scarce and manual modi�cations are still needed
today. 3D Slicer is a freeware that allows the conversion of DICOM data into multiplanar and three-
dimensional data sets. With the segmentation tool "Segment Editor", the cerebral vessels can be most
easily extracted based on the difference in intensity compared to brain-parenchyma in the TOF
gadolinium sequence using the "Threshold tool". The "Island tool" results in the removal of non-connected
structures within seconds and cleans the mesh. This completes the segmentation and the 3D model can
be exported as a Standard Tessellation Language STL �le. The next step is dedicated to geometric
surface preparation. The mesh must be closed, overlapping surfaces removed and holes �lled. These
steps can easily be performed in Meshmixer. The Analysis-Inspector tool automatically corrects the mesh
and prepares it for printing. Furthermore, Meshmixer allows to select and delete undesired structures in a
very quick manner using the selection tool. Geometric surface preparation can be performed entirely by
using Blender, but Mesmixer is far more intuitive to use for the 3D beginner. To smooth the mesh, we used
the sophisticated Laplacian smoothing modi�er in Blender to get the best results. To simplify further
processing and save computing power, the number of vertices of the surface mesh must be reduced
without losing detailed information. For this purpose we used the "Decimate Modi�er" in Blender. With the
preset ratio of 1.0, 100% of vertices will be preserved, but in most cases you will be able to decimate the
vertices by half without losing relevant detail. Therefore, we recommend to choose a ratio of 0.5 which
will e�ciently facilitate further operations. After optimizing the mesh, the 3D reconstruction can be
exported again as a new stl �le. For 3D printing, the �nal stl �le is imported into a printing application.
The print software virtually aligns the model on the corresponding print platform and you are able to set
the parameters for printing. We are using the freeware Cura ( https://ultimaker.com/software/ultimaker-
cura ) for this purpose. Our model was printed in red polylactic acid PLA with an Ultimaker 3 double
extruder �lament printer. The printer reaches a maximal resolution of 0.06 mm layer thickness. For our
purpose, a layer thickness of 0.15 mm was su�cient. As a support �lament we used polyvinyl alcohol
PVA which is conveniently water-soluble. PLA is a thermoplastic material with a high-melting point of
around 250 °C and is suitable for steam sterilization at 121 °C. The total costs of our model of the Circle
of Willis are very low, because we exceptionally use freeware. Therefore only the material has to be paid,
the price for PLA and supporting �lament was below 10$ in our example. There are some one-time costs
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for the printer, in our case they amounted to approximately 4000$, whereby there are also some much
cheaper models available for a few 100$. Alternatively, printing can be outsourced to a print service.

Conclusions
The presented work�ow can be used by any practitioner to quickly generate precise 3D models of the
cerebral vasculature based on standard DICOM data without advanced knowledge in 3D designing and
without spending money on licenses. 3D printed models allow a more intuitive understanding of complex
anatomical structures or pathological processes6. The 3D models will be particularly valuable during
preoperative studies as well as for patient information.
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Figure 1

Segmentation of the cerebral vasculature using DICOM data of a contrast enhanced TOF 3D MRI
sequence using 3D Slicer.
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Figure 2

Easy selection of vessel branches to optimize your model and mesh closure using the inspector tool in
Meshmixer.
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Figure 3

3D reconstruction of the cerebral vasculature smoothened in Blender with construction of a little stand
and engraving of patient number.
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Figure 4

3D printed 1:1 model of the cerebral vasculature in red polylactic acid PLA after dissolving polyvinyl
alcohol PVA support.


